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1 Advanced Studio One Integration

When ATOM SQ is connected to Studio One, the Studio One logo light on the 
ATOM SQ will turn blue. No setup is required. Studio One will automatically 
detect and enable your ATOM SQ for advanced integrated control.

To confirm External Device settings, click on the External Devices link on 
the Studio One Start page and select the ATOM SQ device. From here, you 
can confirm that both the Send and Receive ports are set to “ATOM SQ.”

You can also open the External Device Editor at any 
time by pressing Shift+User the ATOM SQ.

Please note that the ATOM SQ pads, buttons, and touch strip LEDs will remain dark and 
the screen will not have any functions until a New Song is created or an existing Song is 
opened.

Once a New Song is created, all pads will turn white, the screen will default to 
Inst (Instrument) mode and bank buttons A-H will be active, however, until an 
Instrument is loaded into Studio One, the pads and bank buttons have no function.

1.1 Controls

1.1.1 Pad Controllers

All 32 pads on your ATOM SQ are velocity-sensitive. Strikes with less force result 
in a quiet sound, while strikes with more force result in a louder sound (unless 
Full Velocity is enabled). All pads are also sensitive to pressure. After striking 
and pressing down on a pad, more or less pressure can be applied to control 
multiple expressive parameters in Studio One when available (i.e. Aftertouch).

The + and - pads are pressure-sensitive pads only. They can be 
assigned to either Pitch Bend or Breath/Mod Wheel commands

The pads on your ATOM SQ will change colors dynamically, depending 
on what they are currently controlling in Studio One as follows: 

 • Impact XT. While controlling an instance of Impact XT, the pads on your ATOM 
SQ will match the corresponding color of each pad in Impact XT. These colors 
can be changed from within Impact XT. Impact XT as 8 banks of 16 pads. 
Because ATOM SQ features two 16-pad banks, it will display two Impact XT 
banks simultaneously for quick access to multiple banks: A/B, C/D, E/F, and G/H. 
Banks can be changed using the A-H bank buttons. When triggering a sound in 
Impact XT, the pad on your ATOM SQ will change to white while being pressed.

 • Native Studio One or third-party virtual instruments. When controlling 
virtual instruments, the pads on your ATOM SQ will reflect the current Layout 
Mode you have selected. For most virtual instruments, Keyboard Mode will be 
the best choice. When active, Keyboard mode changes the function of the ATOM 
SQ pads to behave in a traditional piano layout. Continuous or Scale Only will 
lay out notes from left to right starting with Pad 1. When triggering a sound, 
each pad on your ATOM SQ will change to Light Blue while being pressed. 
Note: The root of a scale will change color depending on your current track color.

 • Pattern Editor. While the Pattern Editor in Studio One is active, the top lane 
of pads on your ATOM SQ can be used to select the sample or note you would 
like to program. The bottom lane of pads control 16 steps of the Studio One 
step sequencer, allowing the programming of 16 steps in banks of 16. This 
is true for both Drum and Melodic Pattern Modes. While in a pattern mode, 
octaves or banks can be changed using the A-H bank buttons. A step that is 
On will be at full pad brightness while a step that is Off will be very dim. As the 
sequence plays, the pad brightness of the current step will be slightly dim.



2

1 Advanced Studio One Integration 
1.1 Controls

ATOM SQ Production Controller 
Studio One Support

1.1.2 Touch Strip

The touch strip adds expressive control to ATOM SQ. The touch 
strip can be assigned to musical functions like Pitch Bend, 
Modulation Wheel, etc. See Section 31.2.1.3 for details.

1.1.3 A-H Buttons

Use the A-H buttons to switch the current drum bank in Impact XT or change 
the current Octave in Keyboard, Continuous, or Scale Only layout Modes. 

In Keyboard, Continuous, and Scale Only layouts, the A button will always be orange. 
This button is used as a momentary button for Sustain (press and hold for Sustain).

1.1.4 Encoders

The 8 large encoders on your ATOM SQ can back used to control plug-
in parameters when a plug-in is in focus, whether the plug-in is a 
Virtual Instrument, Effect, or Note FX. Depending on which plug-in 
is in focus, the parameter mapped to each encoder will vary. 

All Studio One Native plug-ins have a default mapping, however, these 
controls can be reassigned using the Control Link window. Some third-
party plug-ins may not have a default mapping, in this case, you must 
use Control Link to assign the desired parameter to each encoder. All 
custom assignments will work in any Studio One Song, so you only have 
to make the assignment once to use it anytime you open the plug-in. 

As of Studio One 5.2, ATOM SQ supports Autofill. Open Studio One’s 
External Device Editor and select ATOM SQ. Click the Autofill button 
to have all pages of knob control filled in automatically.

When controlling plug-ins, ATOM SQ supports up to 8 pages of controls in Control 
Link for up to 64 individual controls. Press and hold the User button and press any of 
the A-H buttons to jump directly to a specific control page. You can also access these 
pages from Studio One’s External Device Editor and trigger them with a mouse click.

Power User Tip: Your ATOM SQ encoders have a built-in velocity multiplier, so the faster 
you turn them, the more quickly they will reach the minimum or maximum of the 
parameter range.
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1.1.5 Navigation Buttons

The Up, Down, Left, and Right navigation buttons to the left of the Shift button 
will change their functions depending on what is in focus in Studio One. They can 
go to the next or previous track, navigate the Browser, or select events, notes, and 
Arranger sections. Pressing and holding the ATOM SQ’s Shift button while pressing 
a navigation button will have different behaviors depending on what is in focus at 
the moment. For example, pressing and holding Shift while an Event is selected, 
then pressing Navigation Left will add the Event on the left to the selection.

1.1.6 Transport Buttons

These are dedicated Transport buttons on ATOM SQ. Each button 
has a primary and secondary command. To access the secondary 
command, press and hold Shift while pressing a Transport button.

 • Stop. Stops the transport.

 • Shift + Stop. Undo the last command or action in Studio One.

 • Play. Starts playback from the current position. Press Play to stop playback.

 • Shift + Play. Enables or disables Loop. While enabled, 
the Play button will illuminate blue.

 • Record. Starts recording from current playback position. When the 
Pattern Editor is active, press to enable Record / Step Record.

 • Shift + Record. Saves the current Song.

 • Metronome. Enables or disables the Metronome.

 • Shift + Metronome. Enables or disables the Precount.

1.1.7 Global Controls

ATOM SQ keeps certain commonly used controls and commands available 
at all times to minimize jumping back and forth through different menus. 
These are accessed by pressing and holding down the Shift button while 
pressing any of the A-H buttons or while turning any of the encoders.
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A-H buttons

While accessing their global functions, the A-H buttons will illuminate orange. 
To change these buttons to their global control functions, hold the Shift button 
while pressing the desired button. These are functions that are fixed. Commands 
are shown on ATOM SQ’s screen while pressing and holding the Shift button.

1 2 3 4

5 6 7 8

1. Windows Show/Hide

2. Select All on Track

3. Copy

4. Duplicate

5. Redo

6. Retrospective Record

7. Paste

8. Delete

Encoders 1-8 

Holding down the ATOM SQ’s Shift button will change the knob assignments 
to their global control functions. These are controls that are fixed. 

Power User Tip: Because these knobs have a velocity multiplier built-in, the faster they 
are turned, the more quickly they reach the minimum or maximum value. Slow turns are 
best for precise movements.

1 2 3 4

5 6 7 8

1. Move Loop

2. Vertical Zoom

3. Loop Start

4. Grid

5. Playhead

6. Horizontal Zoom

7. Loop End

8. Nudge
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Screen Encoder

The Screen Encoder also features a global function to change presets. If an 
Instrument, Effect, or Note FX Editor is in focus, pressing and holding the Shift 
button while turning the Screen Encoder will change to the next or previous 
preset. The name of the preset will also briefly show on ATOM SQ’s display. 

Power User Tip: Be sure to save a custom preset before changing the preset or your work 
will be lost! 
 
 
 

Touch Strip

The Touch Strip will control Track Volume when used with the Shift Button. When 
Shift is held, touching the strip and sliding to the left will decrease the selected 
track’s volume and sliding to the right will increase the selected track’s volume. 

Power User Tip: You can also change the touch strip’s primary assignment to Volume 
from the “Performance Config” menu in Inst mode.

1.2 Screen Controls

ATOM SQ’s flexible screen puts many different commands and 
controls at your fingertips. The Page Left and Page Right buttons 
will page through additional screen commands, if available. 

Power User Tip: To quickly jump back to the first page, press the Page Left button a 
second time.

Use the button above or below a function to send a command, enable/
disable functions, or show/hide Studio One windows. Use the Screen Encoder 
to change a selected screen parameter value like Octave, Rate, etc.

ATOM SQ will dynamically follow what function is currently in focus 
in Studio One. Focus is indicated in two different ways:

 • Arrangement, Browser, Editor, and Console. When one of these windows 
is in focus on ATOM SQ, you will see a thin blue rectangle around it.

 • Instrument, Effect, Note FX editors. When one of these editors in 
focus on ATOM SQ, you see a bright yellow button labeled ATOM 
SQ. It the button is not yellow, the editor is not in focus.
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1.2.1 Instrument Mode

When Instrument mode is engaged, the screen on your ATOM SQ will display 
commonly used commands to browse and load Instruments, add or manage 
Events, as well as configure certain pad and performance parameters.

1.2.1.1 Browse

Open Browser

Browse

Instruments Instrument Note FX

Selected Folder Folder

OpenClose

Editor

Load

Browser Editor

1 2 3

4 5 6

1. Instruments Browser. Opens or closes the Instruments tab of the browser. 
Note: that Studio One initially defaults to the “Home” tab at launch. Pressing 
the “Instruments Browser” button will jump directly to the Instruments tab.

 While the Browser is open:

 • Screen Encoder will select the next or previous item in the list

 • Navigation arrows Up, Down, Left, and Right will also select the next 
or previous item in the list. Note: These arrows are different than the Page 
Left and Page Right arrows which are directly below the Screen Encoder.

2. Instrument Editor. Shows or hides the currently 
selected virtual instrument window.

3. Note FX Editor. Shows or hides the Note FX Editor.

4. Load Selected. Loads the currently selected Instrument or Instrument 
Preset onto a new track. Press Shift + Load Selected to replace a track’s 
current Instrument with the newly selected Instrument from the Browser.

5. Close Folder. Closes the current folder or collapses a menu 
depending on the folder tree mode selected in the Browser.

6. Open Folder. Opens the next folder or expands a menu 
depending on the folder tree mode selected in the Browser.
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1.2.1.2 Instrument Track Editing Controls

Page Up to access the Track Editing Controls. From here you 
can add Parts and Patterns, Chorder FX, and more.

Synth Lead

Track

Add Add Merge

Pattern Part

LengthAdd

Events

Add

Chorder FX Arp FX

1 2 3

4 5 6

1. Add Chorder FX. Loads a Chorder Note FX onto the selected track*.

2. Add Arp FX. Loads an Arpeggiator Note FX onto the selected track*.

3. Merge Events. The currently selected Events will be merged together.

4. Add Pattern. Adds a one-bar Pattern Event at the current playhead position.

5. Add Part. Adds a one-bar Instrument Part Event at the current playhead position.

6. Length. Select length to use the Screen Encoder to change the length of the 
selected Event (Instrument Part, Pattern, or Audio) by the Grid amount. 

*  Chorder and Arpeggiator Note FX are available in Studio One Professional.

1.2.1.3 Performance Configuration

Page Up again to access the Performance Configuration page. This page lets 
you adjust the controls on your ATOM SQ to suit your performance needs.

Synth Lead

Performance

Strip +/- Note

1/16 100%

PressureGate

Repeat

Rate

Modwheel Pitchbend

1 2 3

4 5 6

1. Strip. Select Strip to use the Screen Encoder to change 
the function of the Touch Strip as follows:

 • Pitchbend. The Touch Strip will be assigned to the Pitch 
Bend MIDI control and always reset back to center on 
release, indicated by the red LEDs above the strip.

 • Modwheel. The Touch Strip will be assigned to the Modulation Wheel 
MIDI control with minimum value at the far left position and the maximum 
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value at the far right. While active, the modulation will stay in the last 
position that was touched, indicated by the red LEDs above the strip.

 • Expression. The Touch Strip will be assigned to the Expression MIDI 
control with the minimum value at the far left and the maximum value 
at the far right. While active, expression will stay in the last position 
that was touched, indicated by the red LEDs above the strip.

 • Breath CC. The Touch Strip will be assigned to the Breath MIDI 
control with the minimum value at the far left and the maximum 
value at the far right. Breath will stay in the last position that 
was touched (indicated by the red LEDs above the strip).

 • Repeater (Note Repeat). The Touch Strip will use the 8 divisions (tall 
white lines) to change the Note Repeat rate. From left to right: 1/4, 
1/8, 1/16, 1/32, 1/4T, 1/8T, 1/16T, 1/32T. In this mode, all red LEDs will 
remain lit indicating that the Touch Strip is controlling repeat rate.

 • Ch.Vol. The Touch Strip will be assigned to control 
the currently selected track’s volume.

 • Control Link. The Touch Strip will be assignable to any 
parameter using the Control Link function in Studio One.

2. +/-. Select to use the Screen Encoder to change the 
plus and minus buttons assignment:

 • Pitchbend, plus pad will raise the pitch as more pressure is applied 
and minus will lower the pitch as more pressure is applied.

 • Breath/Mod, minus pad’s pressure controls Modulation Wheel 
and the plus pad’s pressure controls the Breath MIDI control.

3. Note Repeat. When enabled, any note(s) played will repeat at the current Rate.

4. Rate. When selected, the Screen Encoder will change Note Repeat’s rate.

5. Gate. Decreases or increases a note’s repeat length.

6. Pressure. Enables or disables the ability to control note 
repeat velocity with more or less pressure.

1.2.1.4 Pad Configuration

Page Up again to access the Pads configuration page. From here you can 
set the layout modes of the pads, set the scale mode, and more.

Synth Lead

Pads

Layout Scale Root

0 0

Full Vel.Range

C

Octave

Keyboard Chromatic

1 2 3

4 5 6

1. Layout. When selected, the Screen Encoder will change how the layout of the 
pads appear. Note that this feature is not available when using Impact XT.

 • Keyboard. Follows the layout of a piano. White keys on the bottom lane 
and black keys on the top lane. If a Scale type is selected (other than 
Chromatic), the bright pads will guide you to play the correct notes in the 
scale. The dim pads are considered “wrong notes” but are still playable.



9

1 Advanced Studio One Integration 
1.2 Screen Controls

ATOM SQ Production Controller 
Studio One Support

 • Continuous. Assigns all pitches from left to right starting from the 
bottom lane (pads 1-16), then continuing in the upper lane (pads 
17-32). If a Scale type is selected (other than Chromatic), the bright 
pads will guide you to play the correct notes in the scale. The dim 
pads are considered “wrong notes” but are still playable.

 • Scale Only. Assigns only the pitches that are part of a selected Scale 
type without access to “wrong notes” from left to right starting from 
the bottom lane (1-16), then continuing to the upper lane (17-32).

2. Scale. When selected, the Screen Encoder will change the pads 
note assignments and bind them to the selected musical Scale. 
Note that this feature is not available when using Impact XT.

 • Chromatic, all possible notes are available

 • Major

 • Melodic Minor

 • Harmonic Minor

 • Natural Minor

 • Major Pentatonic

 • Minor Pentatonic

 • Blues

 • Dorian Minor

 • Mixolydian

 • Phrygian

 • Major Triad

 • Minor Triad

3. Root. When selected, the Screen Encoder will change the Root 
note of a scale (C, C#, D, D#, E, F, F#, G, G#, A, A#, B). The Root note is 
the pad that mirrors the color of whatever the track color is set to. 
Note that this feature is not available when using Impact XT. 

4. Octave. When selected, the Screen Encoder will transpose the 
pads note assignments up or down in musical octaves (7 possible 
octaves). The octave can also be changed using the B-H buttons. 
Note that this feature is not available when using Impact XT. 

5. Range. When selected, the Screen Encoder will move the viewable 
cross-section of a Piano left or right when in Keyboard layout and will 
shift the playable note range of Continuous or Scale Only layouts lower 
or higher. Note that this feature is not available when using Impact XT. 

6. Full Vel. When enabled, notes will always trigger at a fixed velocity of 127.
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1.2.1.5 Advanced Sample Control Mode

It’s possible to control Loop Start/End in Impact XT or SampleOne as well as Sample 
Start/End in SampleOne from an ATOM SQ if you’re using Studio One 5.5 or later.

Impact XT

Press the Instrument (Inst) button on ATOM SQ, then 
navigate to Page 5 titled “Impact Wave Editor.”

NOTE: If there is not an instance of Impact XT or SampleOne on a track,  
Page 5 will read “Sample Wave Editor” and state “No Sampler Track Selected.”

Track Name

Impact Wave Editor 5/5

Zoom Scroll Copy

To Pad

PasteLoop End

Pad

Loop Start

1 2 3

4 5 6

1. Zoom. When selected, use the screen encoder to Zoom 
in or out on the last moved Start or End flag.

2. Scroll. When selected, use the screen encoder to Scroll 
the view of a sample to the left or right.

3. Copy Pad. When pressed, copies the currently 
selected sample and some sample settings.

4. Loop Start. When selected, use the screen encoder to 
move the Loop Start position of the sample.
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5. Loop End. When selected, use the screen encoder to 
move the Loop End position of the sample.

6. Paste to Pad. When pressed, pastes the previously 
copied sample onto a new pad.

SampleOne

Press the Instrument (Inst) button on ATOM SQ, then 
navigate to Page 5 titled “SampleOne Wave Editor.”

NOTE: If there is not an instance of Impact XT or SampleOne on a track,  
Page 5 will read “Sample Wave Editor” and state, “No Sampler Track Selected”.

Start

End

Track Name

Impact Wave Editor 5/5

Zoom Scroll

Loop EndLoop Start

1 2 3

4 5 6

1. Zoom. When selected, use the screen encoder to Zoom 
in or out on the last moved Start or End flag.

2. Scroll. When selected, use the screen encoder to Scroll 
the view of a sample to the left or right.

3. Start. When selected, use the screen encoder to move 
the Sample Start position of the sample.

4. Loop Start. When selected, use the screen encoder to move the Loop Start 
position of the sample. NOTE: Loop must be enabled in SampleOne.

5. Loop End. When selected, use the screen encoder to move the Loop End 
position of the sample. NOTE: Loop must be enabled in SampleOne.

6. End. When selected, use the screen encoder to move 
the Sample End position of the sample.
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1.2.2 Song Mode

ATOM SQ’s Song mode will change the screen to display commonly used 
functions and commands for the overall song like Tempo, showing or hiding 
the Console, adding effects, working with the Arranger Track, etc.

1.2.2.1 Transport

0001.01.01.00

Transport

Tempo Loop Zoom

Marker

IQAdd

Loop

Marker

120.00 Selection

1 2 3

4 5 6

1. Tempo. When selected, the Screen Encoder will 
adjust the tempo in ±1 BPM increments.

2. Loop Selection. The currently selected Event(s) will be used to set Loop In 
and Out points. You must enable/disable looping using the Transport’s Loop 
button. If a loop range has not been set, looping will not be available.

3. Zoom Loop. The selected Event(s) will be used to set the Zoom level.

4. Marker. When selected, the Screen Encoder will 
go to the next or previous marker. 

5. Add Marker. Creates a Marker at the current playhead position.

6. IQ. Enables or disables Input Quantize. When enabled, your performance will 
automatically be quantized after recording (when using a virtual instrument).

1.2.2.2 Console

Synth Lead Track

Console

Console Inspector Volume

0dB

RecMuteSolo

1 2 3

4 5 6

1. Console. Shows or hides Studio One’s Console.

2. Inspector. Shows or hides Studio One’s Inspector.

3. Volume. When selected, the Screen Encoder changes 
the volume of the currently selected track.
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4. Solo. Solos the currently selected track.

5. Mute. Mutes the currently selected track.

6. Rec. Record enables the currently selected track.

1.2.2.3 Arranger Track

Synth Lead Track

Arranger

Toggle Duplicate Delete

Selection

SectionsZoom

Range

Add From

Arranger

1 2 3

4 5 6

1. Toggle Arranger. Opens or closes the Arranger Track.

2. Duplicate. Creates a copy of the currently selected section.

3. Delete Range. Deletes the currently selected section.

4. Add From Selection. Creates a new Arranger section 
from the currently selected Event(s).

5. Zoom. Zooms in or out horizontally.

6. Sections. When selected, the Screen Encoder moves the playhead to 
the next or previous Arranger section and selects that section.

1.2.2.4 Effects

Open Browser

Effects

Effects Channel Devices

Selected Folder Folder

OpenCloseLoad

Browser Editor

1 2 3

4 5 6

1. Effects Browser. Opens or closes the Effects tab of the browser. Note that 
Studio One initially defaults to the Home tab at launch. Pressing the Effects 
Browser button will jump directly to the Effects tab. While the Browser is open:

 • Screen Encoder will select the next or previous item in the list

 • Navigation arrows Up, Down, Left and Right will select the next or previous 
item in the list (note that these arrows are different than the Page Left 
and Page Right arrows which are directly below the Screen Encoder)
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2. Channel Editor. Shows or hides the Effects’ interface, the Effects Editor.

3. Devices. When enabled and the Channel Editor is in focus, the Screen 
Encoder selects the next or previous Effect in the Channel Editor. 

4. Load Selected. Loads the currently selected Effect or Effect Preset onto 
the selected track. This option will always be visible on the screen.

5. Close Folder. Either exits the current folder if available or 
collapses a menu depending on the Tree mode being used for the 
Browser. This option will always be visible on the screen.

6. Open Folder. Either dives into the next folder if available or 
expands a menu depending on the Tree mode being used for the 
Browser. This option will always be visible on the screen.

Note: Load Selected, Close Folder, and Open Folder will be available on the screen 
whether these functions are possible or not. 

1.2.3 Editor Modes

ATOM SQ’s Editor mode will change the screen to display commonly used functions 
and commands for each of Studio One’s Editor windows (Audio, Pattern, and 
Part). Note: Pressing the Editor button will open the respective editor type for 
the currently selected Event(s) in the Editor Window. Pressing the Song or Inst 
buttons will close the Editor window in Studio One and ATOM SQ’s screen will 
change accordingly. The User buttons are also available while in Editor mode.

1.2.3.1 Pattern Editor

When the Pattern Editor is active, these controls will function as follows:

 • Navigation Left and Right Arrows. Bank to the next or previous 16 
steps (if available). Holding down Shift + either Navigation Left or Right 
will select the next or previous Pattern Event in the Arrangement. 

 • Navigation Up and Down Arrows. Select the next or previous 
lane for programming (tapping a pad in the upper lane will also 
select the pad’s respective lane in the Pattern Editor).

 • Plus (+). Use the Plus (+) to add an accent to a step. Press and 
hold +, then tap a pad in the lower lane to add an accent.

 • Minus (-). Use the Minus (-) button to add a tie across multiple steps. Press 
and hold -, then tap a pad in the lower lane where the note should start 
and tap a step later in the pattern where you want the note to end.

Pattern: Variations

Synth Lead Track

Pattern: Variations

New Duplicate Variation

Variation 1

16 1/16 0%

SwingResolutionSteps

Variation Variation

1 2 3

4 5 6

1. New Variation. Creates a new, empty pattern variation.

2. Duplicate Variation. Copies the current variation’s pattern into a new variation.
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3. Variation. When selected, the Screen Encoder will switch 
to the next or previous Variation. If a variation is renamed in 
Studio One, the new name will be reflected here as well.

4. Steps. When selected, the Screen Encoder will change the amount of 
steps for the pattern. If more than 16 steps are created, the Navigation Left 
and Right Arrow buttons will bank to the next or previous 16 steps.

5. Resolution. When selected, the Screen Encoder will change 
the resolution of the pattern to be shorter note durations 
like 1/32 notes, or longer durations like 1/4 notes.

6. Swing. When selected, the Screen Encoder will apply more or less 
swing feel (delaying the 2nd and 4th notes) to the pattern where 
0% is no swing and 100% is the maximum amount of swing.

Pattern: Lanes (Drum Mode only)

Impact XT Track

Pattern: Lanes

Layout Set Every Shift

16 1/16 Lane

ClearResolutionSteps

Drums 4th

1 2 3

4 5 6

1. Layout. Choose between Drums and Melodic layout.

2. Set Every 4th. Fills each 4th step in the selected lane with notes.

3. Shift. When selected, the Screen Encoder will shift 
a lane’s existing notes either right or left.

4. Lane Steps. When selected, the Screen Encoder will change the amount 
of steps in the selected lane independent of a pattern’s steps.

5. Lane Resolution. When selected, the Screen Encoder will change a lane’s 
resolution to shorter or longer durations independent of the pattern’s resolution.

6. Clear Lane. Clears all notes in the selected lane.
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Pattern: Steps

Select a step

Pattern: Steps

Velocity Repeat Delay

Probability

jj

j

j

1 2 3

4

You can edit details of individual Pattern Steps with ATOM SQ. Select 
a Pattern in Studio One and press the left or right arrow keys below 
the screen encoder until you are on the Pattern: Steps page.

Next, tap an active step on ATOM SQ’s lower lane to select 
it for editing. The knob functions are as follows:

Velocity. When selected, the Screen Encoder will change 
the velocity of the currently selected step. 

Repeat. When selected, the Screen Encoder will change 
the amount of times a step is repeated. 

Delay. When selected, the Screen Encoder will change the timing of a step 
either earlier (negative amount) or later (positive amount) from the grid. 

Probability. When selected, the Screen Encoder will change the probability 
that a step will play (100% = always played, 0% = never played). 

To add a new step in the sequence from this page, 
press and hold a pad in the lower lane.

1.2.3.2 Editing Step Automation on the Fly

When in any page other than Patterns: Steps, you can quickly select a 
step to edit by pressing and holding an active step in the lower lane. 

Velocity|Repeat|Delay|Probability

Knobs 5-8

New Duplicate Variation

Steps

VariationVariation

16 1/16 0%

Variation 1

SwingResolution

ATOM SQ’s screen will display “Knobs 5-8” and Velocity | Repeat 
| Delay | Probability. While holding a step in the lower lane, use 
Knobs 5-8 to adjust the corresponding parameters. 

Velocity 63%

Step 9

New Duplicate Variation

Steps

VariationVariation

16 1/16 0%

Variation 1

SwingResolution

As values are changed, the ATOM SQ’s screen will display the currently-edited value.
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1.2.3.3 Part Editor

When in the Part Editor, ATOM SQ’s Navigation Left and Right 
arrows will select the next or previous note. Holding down Shift + 
either Navigation Left or Right will select multiple notes.

Part: Main

Synth Lead Track

Part: Main

Quantize Toggle Grid

VelocityNudgeTranspose

Snap

1 2 3

4 5 6

1. Quantize. Moves all selected notes’ start positions 
precisely on the nearest grid point.

2. Toggle Snap. Toggles snap to grid on or off.

3. Grid. Changes the quantization grid to shorter or longer note values.

4. Transpose. When selected, the Screen Encoder will transpose the 
selected note(s) up or down. Alternatively, the Navigation Up and Down 
buttons will also transpose the selected note(s) up or down. Holding 
down ATOM SQ’s Shift button + either Navigation Up or Down will 
transpose a note Up or Down one musical octave respectively.

5. Nudge. When selected, the Screen Encoder will move the selected 
note(s) left or right depending on the setting of the quantization grid.

6. Velocity. When selected, the Screen Encoder will 
change the velocity of the selected note(s).

Part: Alt

Synth Lead Track

Part: Alt

Humanize Restore Split at

Grid

Part End Part End to Tracks

ExplodeRepeat toExtend to

Timing

1 2 3

4 5 6

1. Humanize. Alters note start and end times and velocity within a 
very small threshold. This provides just enough variation to make 
a performance sound more like a human played the parts.
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2. Restore Timing. Restores the original timing of 
quantized Instrument Parts or notes.

3. Split at Grid. Splits the selected note(s) on the current quantization grid.

4. Extend to Part End. Takes the selected note(s) and 
extends their end points to the end of the Event.

5. Repeat to Part End. Takes a selected note and repeats it 
according to the quantization grid until the end of the Part.

6. Explode to Tracks. Places each pitch within individual 
Instrument Parts on separate tracks.

1.2.3.4 Audio Editor

Audio 1

Vocal Track

Audio 1

Send to Play from Goto Event

Impact

Crossfades

SplitTransientsCreate

Selected

1. Send To Impact. Creates a new instrument track with Impact XT loaded 
and assigns each selected audio Event or each bend marker to a pad.

2. Play from Selected. Moves the playhead to the beginning 
of an Event while the transport is stopped or playing.

3. Goto Event. Moves the playhead to the beginning 
of an Event if the transport is stopped.

4. Create Crossfades. Automatically creates crossfades 
in between selected split audio events.

5. Transients. Moves the playhead to the next or previous transient or Bend Marker.

6. Split. Splits the Event at the current playhead position.

Audio 2

Vocal Track

Audio 2

Send to Reverse Volume

SampleOne

Crossfades

Split at

Grid

Merge

Events

Remove

1 2 3

4 5 6

1. Send To SampleOne. Creates a new instrument track with SampleOne 
XT loaded and assigns each selected audio Event to a piano key.

2. Reverse. Reverses the selected audio Event.

3. Volume. When selected, the Screen Encoder will increase 
or decrease the volume of the Audio Event. NOTE: this does 
not control a channel’s volume in the Console.
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4. Remove Crossfades. Removes crossfades between selected split audio events.

5. Merge Events. Merges the selected events.

6. Split at Grid. Splits the Event at every crossing in the current quantization grid.

1.2.4 User Mode

While in User mode, your ATOM SQ will send any commands currently assigned via 
Studio One’s External Devices Editor.  

To open the External Device Editor in Studio One, select External from the 
far left column in the Console, or press Shift+User on the ATOM SQ.

Double-click on ATOM SQ to bring up the Editor. User buttons have default 
commands assigned, but these can be changed and customized.

To assign a function to any of the ATOM SQ screen buttons, right-
click on the User # label and choose “Assign Command”. 

Select a command from the list then press “OK”, or search for a specific 
command or Macro. After pressing “OK” the selected command will 
be assigned to that User button, and the name of the command will 
appear in that space on ATOM SQ’s screen. User button assignments 
will always be there regardless of the session being worked on.
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While the External Device Editor is open, you can also view the assignments for 
the focused object for 8 knobs on your ATOM SQ and the 8 respective pages.

The default User Button assignments are as follows: 

Page 1:

Page 1/4

User Controls: Global

Add Audio Edit in

Melodyne

Remove

MelodyneTrack

Loop

Tap

Tempo

Zoom to

Selection

Zoom

Page 2:

Page 2/4

User Controls: Global

Convert Convert

To Pattern

Clear

PatternTo Part

View

Score

View

Piano

View

Drum

Page 3:

Page 3/4

User Controls: Global

Scratchpad Toggle

Detached

Tracklist

Track

Apply

Chords

Chord

Selector

Open...

Page 4:

This page displays specialized controls for the Studio One Show Page:

Page 4/4

User Controls: Global

Next

Patch

Next

Setlist

Loop

Setlist

Patch

PerformPrevious

Setlist

Previous

Page 5-8:

These pages are user-customizable. Create the workflow that’s best for you! 

Control Link: Global

Commands 5/8

Not Not Not

Not

assignedassigned

assigned assigned assigned

assigned

NotNot
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